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Be sure to keep all user documentation handy for future reference.
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Important!

The copyright of this User's Guide shall revert to Rahmaquist. All rights related to the software shall
revert to CASIO COMPUTER CO., LTD.

» Microsoft, Windows and Windows Vista are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

» Adobe Reader and Acrobat Reader are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.

» Other product and company names used in this manual may be trademarks or
registered trademarks of others. TM and ® marks are omitted in the text of this user's
guide.



Be sure to read this manual carefully and familiarize yourself with proper operating
procedures before trying to use the software. Keep the manual in a safe place for
future reference when required.

User’s Guide Precautions

+ Contact a nearby dealer whenever you require servicing.

 Note that the manufacturer shall not be held liable for any loss or claims by third
parties which may arise out of the use of this product.

» Note that the manufacturer shall not be held liable for any damages incurred as a
result of data loss caused by malfunctions, repairs, or interruption of power supply.

« It is up to the user to keep backup records of important data.

| - STP-1200 Label Printing Software is designed to run under Windows Vista, XP, |
I 2000 Professional. I
« Certain computer system configurations can make it impossible for this software
to run properly.
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About this manual...

Note the following important points when using this manual.

B STP-1200 Label Printing Software
» All mentions of “the Label Software” in this manual refer to the STP-1200 Label
Printing Software.

B Windows operations are not covered.
This manual describes operation of STP-1200 Label Printing Software Version 2.0 for
Windows (Vista, XP, 2000 Professional) only. The explanations in this manual assume
that you are already familiar with the following basic Windows operations.

« Click, double-click, right-click, drag, drag and drop, and other mouse operations

» Menu operations using the mouse

« Text input using the keyboard

« Common Windows window operations
If you are unfamiliar with these or other Windows operations, see the documentation
that came with your computer or the version of Windows you are using.

The Label Software has a help function (page 54) you can use to access operational
information on your computer.




B Menus and Buttons

All explanations in this manual assume that on-screen menu and button operations
are performed using the mouse.

 The following shows an example of executing a menu command.

Properties... t\!\

Capture Panel
Help 3
Exit

Click Input Panel .

 The following shows an example of clicking a dialog box button.

STP-1200 Label Printing Software E'

\_Z!') OK to start printing?

Cancel |

Click OK.

H Key Operations
Computer keyboard operations are indicated in this manual as follows: Ctrl key, Shift
key, Alt key.

H Screens
Note that the screen shots that appear in this manual may differ somewhat from the
screens that appear on your computer screen.

All of the sample screens in this manual show operation under the English version
of Windows XP. Screens appear differently when running the application under
another operating system.




Getting Acquainted

The Label Software makes it possible for you to create and edit labels on your computer.

STP-1200 Label Printing Software Functions

H Incorporate images into labels.
» 136 images included (page 36)

% o rc‘
24
D \\’

» Screen image capture (page 38)

c=x

H Use fonts installed on your computer in labels
(pages 17, 45).

Thank you! | | Thank you!
Thank you!




H Instantly print text you are inputting or editing with other
software on your computer screen (page 29).

Charity EESI=s

Hold down
Ctrl and then

Show

» EIT—

penu:l ‘

Right-click!

B Character size is adjusted automatically, for quick and easy

printing.

Selecting three lines

Charlty Dinner Show
S ption Hall, Hotel

Century

p.m. to 10:00 p.m.
Price: §50 & Brint k
% Append

& Save Phrase L4
Conkext Menu. ..

Properties

Right-click Settings

We announce that the Dinner 3how is held as follows:

Selecting one line

Charity DIinner Show
Reception Hall, Hotel Century

Saturday,

September Z8&
§:00 p.m. to 10:00

| EFINE K
% Append

Price: §50

& Save Phrase L4
Context Menu, ..
Properties

Right-click. Settings

We announce that the Dinner 3how is held as follows:

Reception Hall, Hotel Century
Saturday, September 23
8:00 p.m. to 10:00 p.m.

Saturday, September 28




H Keep it running for instant label printing whenever you need
it. Does not interfere with other programs.

Label Software icon

* You can also shut down the Label Software when you want (page 13).

H Register often-used terms and expressions for quick and
easy input (page 26).

H USB port for easy connection to a computer

H View the image of a label on your computer screen before
printing it.
» Executing a print operation from the shortcut menu displays a preview dialog box
that shows an image of what the printed label will look like.
* You can also display a preview window while inputting text into the Input Panel.
You can configure the Label Software so the preview image is not displayed, if
you want (“Preview Window,” page 18).

Hl Store up to 100 past print jobs for later recall when you want
to print again (“Recalling and Deleting Past Print Jobs,” page
39).

Note

* Right-clicking your mouse while the Label Software is running normally displays the
Label Software shortcut menu. You can also set up the Label Software so the shortcut
menu of the application you are using for editing appears instead (“Configuring
Shortcut Menu Operation,” page 49).
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Shortcut Menu Operation

Normally after you install the Label Software, hold down Ctrl and then right-click in
the word processor, e-mail, or other application you are using to display the Label
Software shortcut menu.

Print — Label Software shortcut
menu*
% append
* A different menu
& Save PhHrase ¥ appears if you right-click
| the Label Software icon
Conkexk Menu. .. in the status area.
Froperties
Right-click Setkings

If you want to display the shortcut menu for the other application you are using, select
Context Menu on the Label Software shortcut menu.

* See “Configuring Shortcut Menu Operation” on page 49 for information about disabling

display of the Label Software shortcut menu, and configuring modifier keys to control
which shortcut menu appears.

Disabling Auto Startup of the Label Software

If you selected the auto startup option for the Label Software when you installed it
(see the “Read this first” sheet), you can use the following procedure to disable auto
startup.

1 Right-click the Windows Start button.
On the menu that appears, click Open All Users.
On the window that appears, double-click Programs.

Double-click the Startup folder.

o~ WOD

Delete the STP-1200 Label Printing Software icon.
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Starting Up and Quitting
the Label Software

You do not need to perform this procedure if the Label Software icon is already in the
status area, which indicates the Label Software is already running.

Windows status area (normally located in the lower right corner of your screen)

Label Software icon (Indicates Label Software is running.)

To start up the Label Software

91 On the Windows desktop, double-click the STP-1200 Label Printing

Software icon.

This starts up the Label Software and displays the Input Panel and the preview

window. It also causes the Label Software icon to appear in the Windows status

area.

* You can also start up by clicking the following: Start = All programs < SERAMA
TECH=» Label Printing Software =» STP-1200 Label Printing Software. What
you need to click may be different, depending on the folder where you installed
the Label Software.

‘ Preview window

< |+]

2L STP=1200 Label Printing Software

History e
i - ‘&@ EEEE T j‘gﬁ g J '
iLabel Printin Width  Length FixedLayout  Ima; i
..... 5 I]'r't'i".'EFEg rial RaNIERRS 7og v AStu - Nu:e -

Double-click | Input Panel
< [+
Prnter  Manins Copies
> | B B |Smal| =T = pringy

Label Software icon
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1 Right-click the Label Software icon in the Windows status area.

2 On the menu that appears, click EXxit.
This quits the Label Software, which causes the Label Software icon to disappear
from the status area.

Input Panel
Properties...
Capture Panel

Help 3

13



User Interface

This section explains all of the screens and menus that appear on your computer
display while you are using the Label Software. For full details about operational
procedures, see the pages that are referenced in this section.

Input Panel

o 20 ® ©® © ® ® ® ® ®O

=14 STP:1200 LabuslPrinting Software

—®@
idth Length  FixedLayout Image o
=] 18 =] [0 2] W [auo =] [mone =] | ®
|
| ' =
® @

®
@

-
| | [
~ Printer Margins Copies

8 [sTP-1200 | ﬂlSmail BN E T_[ M——
|

I I
() @ O

@ Recall Phrase Button
Recalls a previously saved term or expression for insertion into the Text Input Box.
+ See “Inserting Phrases, and the Current Date and Time” on page 26.

® Save Phrase Button
Saves the text that is highlighted in the Text Input Box into phrase memory.
+ See “Saving Text in Phrase Memory” on page 27.

® History Box
Displays a history of past print jobs.
» See “To recall a past print job” on page 39.
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@ Top Button
Displays the oldest entry in the history of past print jobs.
» See “To recall a past print job” on page 39.

® Back Button
Displays the next older job in the history of past print jobs.
» See “To recall a past print job” on page 39.

® Forward Button
Displays the next newer entry in the history of past print jobs.
» See “To recall a past print job” on page 39.

@ New Button
Displays the text you are currently editing.
+ See “To recall a past print job” on page 39.

Tape Feed Button
Feeds the tape.
» See “To feed the tape” on page 41.

© Tape Cut Button
Cuts the tape. This function is supported only for label printers that are equipped
with an auto cutter.
» See “To cut the tape” on page 41.

Insert Image Button
Displays a window for selecting an image.
» See “To insert an existing image into a label” on page 36.

@ Capture Image Button
Captures an image from your computer screen for pasting into a label.
» See “To capture an image from your computer screen” on page 38.

® Help Button
Displays help.
» See “Using Help” on page 54.

® Close Button
Closes the Input Panel.

Properties Button
Displays a Label Software properties dialog box.
» See “Configuring Label Software Properties” on page 42.

15



® Trash Button
Deletes the contents of the Text Input Box. If the contents of the Text Input Box are
a past print job selected using the History Box, clicking this button deletes the past
job.
 See “Inputting, Editing, and Printing Text” on page 23, and “To delete a past print
job” on page 40.

Image Box
Shows the Image paste size and location.

@ Layout Box
Specifies the character size and number of lines. The contents of this box differ
according to the type of tape being used for printing.
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label
Software Properties” on page 42.

Fixed Tape Length Check Box
Specifies whether the tape length should be fixed (checked) or variable (unchecked).
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label
Software Properties” on page 42.

Print Button
Prints the text in the Text Input Box. This button becomes a Cancel Printing button
while printing is in progress.
+ See “Inputting, Editing, and Printing Text” on page 23.

Copies Box
Specifies the number of copies of the label to be printed.
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label
Software Properties” on page 42.

@ Margins Box
Specifies the size of the left and right margins of the tape.
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label
Software Properties” on page 42.

@ Text Input Box
Use this box to input and edit text for printing.
 See “Inputting, Editing, and Printing Text” on page 23.

@ Printer Model Box
Indicates the printer model name (STP-1200).
« Selection of any other printer model is not supported.

16



Show/Hide Preview Button
Toggles display of the print image preview on and off.
* You can resize the Preview Window by dragging its boundaries.
» See “Preview Window” on page 18.

@ Tape Length Box
Specifies the tape length.
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label

Software Properties” on page 42.

Tape Width Box
Specifies the tape widtg«
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label

Software Properties” on page 42.

@ Font Box
Specifies the text font.
» See “Inputting, Editing, and Printing Text” on page 23 and “Configuring Label

Software Properties” on page 42.

Important!
You can use the properties dialog box to configure the same settings that appear

on the Input Panel. See “Configuring Label Software Properties” on page 42 for
more information.

* You can change the size of the Input Panel by dragging its borders.

Toolbar Button Name Display

MOVing the mouse pointer over a Ll=BTP-1200LabslPrinting Software HE

toolbar button causes the name of the Mooy ol ol el
button to appear on your screen. ‘&Y@ 'EEE " ﬁg@ -l 5 W]

* Moving the mouse pointer tothe Tape 77— aeprse] 57 (=058, S8R A= =0 7

Length Box causes the allowable —
tape length settings to appear. g
i | |* =

. Printer Margins Copies
e [ =l |fsman =110 = Prinid

Toolbar button name
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You can use the preview window to view the print image of a label before printing.

Preview —The planning meeting starts at 13:00
At room 4

| — Scroll bars
ali STP-1200 Label Printing Software HE

@@m‘zgfﬁgﬁw

Width  Length _FixedLayout  Image

Times New Roman | [18 ~]||[70 =] k| [auto =] [None =

The planning mesting starts at 12:00 B
At room 4 ’_
‘ Text Input Box
| R
. Printer Margins Copies
? STF- 1200 | Jsmat | [t =i Print

|
Show/Hide Preview Button
« 5§ when preview is displayed.
* 58 when preview is not displayed

» The preview window shows what the text in the Text Input Box will look like when it
is printed.

» Font, tape width, tape length, and layout settings are all reflected in the preview
image.

« Clicking the Show/Hide Preview button toggles display of the preview window on
and off, except when there is no text in the Text Input Box.

» Some label contents can cause the preview window to be too small, which makes
the preview image appear ragged. If this happens, make the preview window larger
by dragging its borders.

* You can use the scroll bars to view the areas of the label that do not appear within
the preview window. If you are creating multiple labels, use the up/down scroll bar to
scroll between labels.

» When laying out an image, you can also specify grayscale display of images in the
preview window instead of binary display. See “Configuring Display Settings” on
page 48 for more information.

18



Preview Dialog Box

Whenever you have the Input Panel preview window hidden (display turned off), a
preview dialog box appears automatically when you execute the Print command. You
can use the preview dialog box to check the appearance of the printed label before
proceeding with the print operation.

Preview @

The planning meeting starts at 13:00
Atroom 4

|

10
|

— Scroll bars

Current IayoutJ |—Total number of layouts

» The preview dialog box shows what the text in the Text Input Box will look like when
it is printed.

 The total number of layouts value shows how many different layouts you are printing
with the current print operation. When this value is greater than 1, use the vertical
scroll bar to scroll between the different layouts.

» The current layout value indicates which layout is currently displayed. If you are
going to print three different layouts, for example, this value shows 1, 2, or 3,
depending on the layout that is displayed.

« The current layout value and total number of layouts value do not indicate the number
of labels that will be printed. You can determine the number of labels by multiplying
the total number of layouts value by the Copies value you specified on page 24.

» Some label contents can cause the preview dialog box to be too small, which makes
the preview image appear ragged. If this happens, make the preview dialog box
larger by dragging its borders.

* You can use the scroll bars to view the areas of the label that do not appear within
the preview dialog box.

« Clicking the Print button starts actual printing.

« Clicking the Cancel button cancels the print operation.

* You can configure the Label Software so the preview dialog box does not appear
before printing (“Configuring Display Settings”, page 48).

19



This section describes the contents of the two shortcut menus that appear when you

right-click your mouse while the Label Software is running.

» See “Configuring Shortcut Menu Operation” on page 49 for information about to
configure settings that control shortcut menu operations.

H Shortcut menu that appears when you right-click the screen
The following is the shortcut menu that appears when you hold down Ctrl and then
right-click your word processor, mail, or browser software screen while the Label
Software is running.

®— 2 Print
®— % A 4 * You can also configure the Label
&ppen Software so items ® through ® do
not appear on the shortcut menu
— 3
® Save Phrase (“Configuring Shortcut Menu
@ — [g] Context Meru... Settings”, page 48).
®— Properties
®— Right-click Settings
@ Print
Prints text that is currently selected (highlighted) in the other application you are
using.
» See “To import and print a single string of text” on page 29.
@ Append

Copies text that is currently selected (highlighted) in the other application you are
using into the Input Panel. After collecting the text from various locations, you can
print it.

» See “Multiple Text Strings and Printing a Single Label” on page 31.

® Save Phrase*
Saves text into phrase memory.
» See “Saving Text in Phrase Memory” on page 27.

@ Context Menu*
Displays the shortcut menu of the other application (word processor, mail, browser)
you are using.

® Properties*
Displays a dialog box of Label Software properties.
» See “Configuring Label Software Properties” on page 42.

® Right-click Settings*
Displays a dialog box for configuring settings that control what happens when you
hold down Ctrl and then right-click your mouse. This menu item appears when
display of the Properties menu item is enabled.
+ See “Configuring Shortcut Menu Operation” on page 49.

20



H Shortcut menu that appears when you right-click the Label

Software icon
The following is the shortcut menu that appears when you right-click the Label Software
icon in the Windows status area.

@ Input Panel

® Properties. ..
® Capture Panel

@ Help v
® Exit

Label Software icon

@ Input Panel
Displays the Input Panel.
» See “Input Panel” on page 14.

® Properties
Displays a dialog box of Label Software properties.
» See “Configuring Label Software Properties” on page 42.

® Capture Panel
Displays the capture panel, which you can use to capture an image from your
computer screen without displaying the Input Panel.
» See “To capture an image from your computer screen” on page 38.

Capture Panel

21



@ Help
Displays a help submenu.

+ See “To access help from the status area icon” on page 55, and “To view version

information” on page 55.

Input Panel

Properties...

Capture Panel
Search by Topic Help r
About the Label Printer Application Exit

Help submenu

® Exit
Quits the Label Software.
+ See “Quitting” on page 13.

22



Inputting, Editing, and Printing
Text

This section explains how to use the Input Panel to input and edit text, and then print

it.

To input, edit, and print text

If the Label Software is already running, click the Label Software icon
in the status area.

This displays the Input Panel. The preview window should also appear, unless itis
hidden (page 18).

1

If the Label Software is not running, double click the Label Software icon on
your Windows desktop. After the Input Panel appears, proceed with step 2.

Use the Text Input Box to input and edit the text you want to print.

The contents of the preview window will change as you input and edit the text.
Clicking the Trash button deletes all of the text in the Text Input Box.

You can input up to 255 characters per line. A carriage return will be inserted
automatically if your input exceeds this limit.

The allowable number of characters per line is further limited when you are
using a fixed tape length. A carriage return is inserted automatically whenever
your input surpasses the maximum allowable line length.

See “Input Panel” on page 14 for information about specifying font, tape width,
tape length, and other settings.

See “Inserting an Image into a Label” on page 34 for information about inserting
an image into a label.

See “Inserting Phrases, and the Current Date and Time” on page 26 for
information about inserting often-used phrases and the current date and time
into a label.

See “Configuring Add-in Settings” on page 52 for information about printing
mirror images onto iron transfer tape.
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3 Configure Font, Width, Length, and Layout settings.

* Your settings will be reflected in the preview window, so you can see what your
printed label will look like.

« If you have Auto selected for Layout, the size of text will be adjusted automatically
so it fits within the specified tape length. If you have Title specified for Layout,
the first line will be middle size, while all remaining lines will be small size text.

» The tape length setting is ignored when you are printing to thermal roll paper.

 To specify a fixed-length tape, select the Fixed check box. The length of the
tape changes automatically in accordance with the text when this check box is
cleared.

» Note that some settings may not be available when using a label printer model
that does not support them.

Preview window —— W
| will pick you up at 7:00 o'clock evening.
Reserved the restaurant 7:30 p.m.
[ 1+
-1=5TP-1200-LabelPrinting Software: HE
- [ [ =
Wldth Font mn,m ﬂLength FixedLayout  Image
Font ———Ffeia =] 19 = [0, 2 & Aulul | [Mone ~ @
1wl pick you up et 7:00 c'clock evenir L Layout
Reserved the restaurant 7:30 p.m .
Text Input Box — ] Fixed
‘ o Length
Frinter Margins Copies .
=l | “lfsma =] [1 =] pring=—— Print Button
Printer Margins —  Copies

4 Check to make sure the Label Printer is connected correctly to your
computer.
You can connect the Label Printer to your computer any time before you click the
Print button in step 6.

B Specify the number of copies and margin size.
6 Click the Print button.
« This causes a confirmation message to appear.

« If you do not have the preview window displayed along with the Input Panel, the
preview dialog box will appear at this time.
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7 Click OK.
« This starts actual printing.
* You can also start printing by holding down Alt and pressing P.
« To cancel the print operation, click Cancel.
« Clicking the Stop button stops printing. You can also stop printing by holding
down Alt and pressing S.
« If the preview dialog box appeared in step 6, click Print to start printing.

Important!

» Never disconnect the cable between the Label Printer and computer while printing is
in progress.

 Never try printing on the STP-1200 printer from the Label Software and the SERAMA
TECH PRINTER Application at the same time.

25



Inserting Phrases, and the
Current Date and Time

The Label Software comes pre-programmed with 103 different often-used expressions
and phrases that you can recall and input into a label. In addition, you can also store
your own phrases for instant recall when you need them.

To insert phrases, and the current date and time

91 Onthe Input Panel, click the Recall Phrase button.
This displays a menu of phrase categories.

=U=8TP=1200Label Printing Software 27 1x]

: H\slury : i R i 31|

recal Prvase —Safil s o ) o)
utto Font Width  Length Fixedlayout  Image i
| Avrial e 70 =+ Ao =] [L-5m =] ﬁ

I =

| I'F‘

. Printer Margins Copies

ﬁ [ =l[[smar =]+ 21 Pringy

2 Align the mouse pointer with the category of the phrase you want to
input. On the submenu that appears, click the phrase you want to input.
« To input a date and time, select the Time Stamp category.

=1—5TP-1200 Label Printing Software =1-5TP-1200 Label Printing Software
W 3 [History T B ‘:; Rag e I History - o il 1ol
WA = S &l 8] ] WA a3 e
Business 4 Wiidth  lennth  Fixedlayout  Image 2 Font Width  Length FixedLayout  Image
Happy! V! [auto =|[L8m ~ ﬁ Arial = 1z =] {70 2{[F [aute =] [Lsm ~ ﬁ
Time Stamp  » Merry Christmas! J
Happy Birthday! - 9 Thank you! -
Present For You g
For You
‘l Iam sorry! I ‘l I
 Printer Margins Copies  Printer Margins Copies
e | s =1 2| Pringy x| | Jsmat = [1 =] Print

26



Time Stamp Formats

Clicking this menu item: | Inputs this:*
mm/dd/yy 10/18/05
dd/mm/yyyy 18/10/2006
yyyy-mm-dd 2006-10-18
dd-mmm-yy 18-Oct-05

d mmmm yyyy 18 October 2006
h:mm 14:00

h:mm AM/PM 2:00 PM

* The input examples shown here are what would be input when the current date and
time setting of your computer is October 18, 2006, 2:00 pm.

Saving Text in Phrase Memory

Three categories named USER 1, USER 2, and USER 3 are provided for saving your
own original phrases and expressions in phrase memory. Each category can hold up
to 30 phrases.

To save a text in phrase memory
91 Onthe Input Panel, select (highlight) the text you want to save.

2 Click the Save Phrase button.
This displays a group selection menu.

=1 STP-1200 Label Printing Software
Save Phrase Button ——

ﬁ @ History ———

Width  Length Fixedlayout  Image

e Y
aral | USER2 [1z =] [70 =]/ [aue =] [tone =]

Text Input Box ———— F‘
I :

il

Printas Marging Copies
Ehw—wzuu ] [smar =] [ =] P.ri-nti

* You can also save text that is selected on a part of the screen outside the
Text Input Box as well. Right-click the selected text and then click Save Phrase
on the shortcut menu that appears. Note that depending on how you have
the Label Software configured, the Save Phrase item may not appear.

» See “Configuring Shortcut Menu Settings” on page 48 for information about
displaying the Save Phrase item.
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3 Click the group where you want to save the text.
The highlighted text is saved into phrase memory.

M Editing Phrase Memory Text

See “Editing Phrase Memory Text” on page 47 for information about deleting and
changing the order of phrase memory text.
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Importing Screen Text into a Label

This section explains how to import text that is selected on a word processor, browser,
or other application screen into a label for printing. You can import a single string of
text, or you can accumulate multiple strings from different locations.

As an example, the following procedure shows how to import and print text from
Microsoft Internet Explorer.

To import and print a single string of text

91 Check to make sure the Label Printer is connected correctly to your
computer.
You can connect the Label Printer to your computer any time before you click the
Print button in step 6.

2 lfthe Label Software is already running, highlight the text you want to
print.
* You can input up to 255 characters per line. A carriage return will be inserted
automatically if your input exceeds this limit.
» The allowable number of characters per line is further limited when you are
using a fixed tape length. A carriage return is inserted automatically whenever
your input surpasses the maximum allowable line length.

3 Hold down Ctrl and then right-click with your mouse.

29



On the shortcut menu that appears, click Print.

This causes the preview dialog box to appear.

» The total number of layouts value shows how many different layouts you are
printing with the current print operation. When this value is greater than 1, use
the vertical scroll bar to scroll between the different layouts.

 The current layout value indicates which layout is currently displayed. If you are
going to print three different layouts, for example, this value shows 1, 2, or 3,
depending on the layout that is displayed.

* You can determine the number of labels by multiplying the total number of layouts
value by the Copies value you specify in the next step.

» Some label contents can cause the preview dialog box to be too small, which
makes the preview image appear ragged. If this happens, make the preview
dialog box larger by dragging its borders.

* You can use the scroll bars to view the areas of the label that do not appear
within the preview dialog box.

» See “Configuring Printing Properties” on page 43 for information about changing
the print image.

Rahmqvist “ |

— Scroll bars

_'.._|_
Current layout % Copins|! =3[Pt | Cancel

Total number of layouts

Specify the number of copies.

Click the Print button.

* This starts printing.

* You can also start printing by holding down Alt and pressing P.

« To cancel the print operation, click Cancel.

« Clicking the Stop button stops printing. You can also stop printing by holding
down Alt and pressing S.

Important!

» Never disconnect the cable between the Label Printer and computer while printing is
in progress.

» Never try printing on the STP-1200 printer from the Label Software and the SERAMA
TECH PRINTER at the same time.
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Multiple Text Strings and Printing a Single Label

Perform the following steps when you want to accumulate a number of different text
strings for printing in a single label.

As an example, the following procedure shows how to import and print text from
Microsoft Internet Explorer.

To accumulate multiple text strings and print a single label

1 Check to make sure the STP-1200 is connected correctly to your
computer.
You can connect the STP-1200 to your computer any time before you click the
Print button in step 9.

2 Ifthe Label Software is already running, highlight the first string of text
you want to import.

3 Hold down Ctrl and then right-click the mouse.

4 Click Append.
This displays the Input Panel with the text you selected in step 2 in the Text Input Box.
» See “Input Panel” on page 14 for more information about the Input Panel.

=U=5TP=1200 Label Printing Software k3
' o | History L 1 o 1M
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Font
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<
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|_ Input Panel
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 Printer Margins Copies
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B Highlight the next string of text you want to import, hold down Ctrl and
then right-click with your mouse, and then click Append.

« This appends the new text to the text that is already in the Text Input Box.

* You can input up to 255 characters per line. A carriage return will be inserted
automatically if your input exceeds this limit.

» The allowable number of characters per line is further limited when you are
using a fixed tape length. A carriage return is inserted automatically whenever
your input surpasses the maximum allowable line length.

* You can use the scroll bars to scroll the Text Input Box and view any text that

does not fit.
=U=5TP=1200 Label Printing Software k3

A [Hist = -
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© After appending all the text strings you want, edit the text in the Text
Input Box, if you want.

7 Configure Font, Width, Length, and Layout settings.

* Your settings will be reflected in the preview window, so you can see what your
printed label will look like.

« If you have Auto selected for Layout, the size of text will be adjusted automatically
so it fits within the specified tape length. If you have Title specified for Layout,
the first line will be middle size, while all remaining lines will be small size text.

» The tape length setting is ignored when you are printing to thermal roll paper.

 To specify a fixed-length tape, select the Fixed check box. The length of the
tape changes automatically in accordance with the text when this check box is
cleared.

» Note that some settings may not be available when using a label printer model
that does not support them.
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Preview window ——
Rahmgqvist

business concept
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Printer Margins Copies

8 Specify the number of copies and margin size.

O Click the Print button.
This causes a confirmation message to appear.
« If you do not have the preview window displayed along with the Input Panel, the
preview dialog box will appear at this time.

1() Click OK.
* This starts actual printing.
* You can also start printing by holding down Alt and pressing P.
« To cancel the print operation, click Cancel.
« Clicking the Stop button stops printing. You can also stop printing by holding
down Alt and pressing S.
« If the preview dialog box appeared in step 9, click Print to start printing.

Important!

» Never disconnect the cable between the STP-1200 printer and computer while printing
is in progress.

* Never try printing on the STP-1200 printer from the Label Software and the SERAMA
TECH PRINTER Application at the same time.
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Inserting an Image into a Label

This Label Software comes with a collection of images that you can insert into your

labels. You can also capture an image from your PC screen into a label. Inserting an
image into a label consists of the following steps.

« Specify the location and size of the image.

+ Specify an existing image or capture a new one.
Note that you can adjust the size and location of an image after you insert it into a
label.
A captured image that has fine gray scaling may not look good when printed in a

label. When capturing an image to insert into a label, it is best to stick with those that
have clearly defined blacks and whites.

To specify the location of the image
1 Usethe Image Box to specify the insert location and size of the image.

=1=STP-1200Label Printing Software
SR TFr
Font Width  Length FixedLayout  Image
[rict | 1 w70 M e ¥ |NoneL@——lmage Box
L-Sm
R-Zm
L-Lg
R-Lg
Ful
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| |
Printer Margins Coples
%| = Jsmar I [ Pringy
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The following shows examples of what each of the available options does.
L-Sm b

(Left Small) .

R-Sm @
(Right Small)

L-Lg oy

(Left Large) o

R-Lg

(Right Large)

Full
(Full Tape)

None
(None)

* You can overlay text and images with the Full Tape option. If you select Full
Tape while the Fixed check box is cleared, a preview image does not appear in
the preview window until you input some text.

» Note that the image is not inserted when None is selected.

» Note that the text input range is smaller when any setting other than None is
selected in the Image Box.

After specifying the location and size of the image, perform the steps
under “To insert an existing image into a label” or “To capture an image
from your computer screen” on the following pages.
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To insert an existing image into a label

1 Click |
This displays an image selection window.

2li=5TP=1200-Label -PrintingSoftware EE3
: [ Insert Image Button
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Frinter Margins Capies
@| S Jemen =] 12 Pringy

 Note that the Insert Image Button appears dimmed, which means it is unavailable,
when None is selected in the Image Box.

2 Click the folder that contains the image you want on the left panel of
the window, and then click the image you want on the right pane.
» See “Image Folder Contents” on the next page for information about the types of
images stored in each folder.

all) Select Image |E|E|

‘C “Program Filesh\SERAMA TECHAS TP-120005 amplestllustrations s llustrations-S mally j

8] a| i

=13 SER&MA TECH
{C) SER&MA TECH PRINTER

=3 STP-1200 A01BMP 02 BMP
+-3) Addins
+-) Bin
=[5 Samples 1
#-3) Frame(For Full-Tape Image ;‘i}
= Mushiations ‘

A03BMP 404 BMP

12 Iustrations-Large
] llLstrations-Sma

ocoooo

|~
»

| Cancel | Help

3 After selecting the image you want, click OK.
This inserts the image you selected into the label using the location and size
settings you specified on page 34.
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Image Folder Contents

The STP-1200 Label Printing Software Version 2.0 comes with 136 sample images,
which are normally located in Programs Files - SERAMATECH - STP-1200 - Samples.
If you specified a different location for STP-1200 - Samples when you installed the
software, you will need to go to that location to access the images.

M lllustrations - lllustrations-Large
* 44 fun graphic images, measuring 256 x 256 pixels.

M lllustrations - lllustrations-Small
* 44 fun graphic images, measuring 128 x 128 pixels.
» The perfect size for 18mm tape.

B Frame (For Full-Tape Image) — For Label Printer Tape (Width-
Large)
 Acollection of 12 frames measuring 64 x 512 pixels.
» The aspect ratio (width:height) is 8:1. Best layout results are achieved using a tape
with a similar aspect ratio.”

B Frame (For Full-Tape Image) — For Label Printer Tape (Width-
Medium)

» Acollection of 12 frames measuring 64 x 384 pixels.
» The aspect ratio (width:height) is 6:1. Best layout results are achieved using a tape
with a similar aspect ratio.”

B Frame (For Full-Tape Image) — For Label Printer Tape (Width-
Small)
+ Acollection of 12 frames measuring 64 x 256 pixels.
» The aspect ratio (width:height) is 4:1. Best layout results are achieved using a tape
with a similar aspect ratio.”

* When you have Full Tape selected in the Layout box on the Image tab of the
properties dialog box (or Full Tape selected in the Image box of the Input Panel), be
sure to input enough space and adjust the position of text so it does not overlap with
image elements.
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Capturing an Image from Your Computer Screen

Perform the following steps when you want to capture an image from your computer
screen and incorporate it into a label.

To capture an image from your computer screen

1
2

Display the screen that contains the image you want to capture.

This closes the Input Panel.

» The Capture Image Button appears dimmed, which means it is unavailable,
when None is selected in the Image Box.

* You could also start the image capture operation by clicking the Capture Panel
instead of the Capture Image button. You can use the Capture Panel to capture
an image without displaying the Input Panel. See “Shortcut menu that appears
when you right-click the Label Software icon” on page 21 for more information.

« To cancel the capture operation, press the Esc key.

=l=5TP-1200Label Printing Software EE3

nd el oy ... _ ———1 Capture Image
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3 Drag the mouse pointer on the screen so the area to be captured is

enclosed within the selection boundary.
» The area within the selection boundary is the image that will be captured.
e I e ot o]

-> Rahmavist)

|
The image within the
boundary is inserted into
the label.

o B i

The area where you These guidelines indicate an area that
drag is surrounded by a  corresponds to the label layout size.

selection boundary.
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Recalling and Deleting Past
Print Jobs

The Label Software stores up to 100 of the last jobs you have printed. You can recall
print jobs for re-printing or editing, and delete jobs you no longer need.

To recall a past print job

91 On the Input Panel, use the Top, Back, Forward, and New buttons to
display the print job you want to recall.

Top Button
Displays the oldest
entry in the history
of past print jobs.

Back Button

Indicates the total number of print jobs and the currently
displayed print job number. This example indicates this is

the fourth print job out of a total of five jobs.

Font

=l=STP-1200 Label rinting Software

|

Width

Length Fixedlayout  Image

‘Ar\a\

[1e 4

:| (70 [V Auto =] [none =] L I

Robert Jones

— New Button

Displays the contents
of the label you are
currently editing.

Displays the next
older job in the
history of past print
jobs.

<

I

4Pl|mE
= |

Margins Copiss
| fsmar =] [1 2] Print

Forward Button
Displays the next
newer entry in the
history of past print
jobs.

2 Input new text, edit the existing text, or print the label.
 See “Inputting, Editing, and Printing Text” on page 23 for more information.
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To delete a past print job

1 Display the past print job you want to delete.
» See step 1 under “To recall a past print job” on page 39.

2 Click the Trash Button.
This deletes the displayed print job.

The print job count is reduced by 1.

T—8TP-1200-Label’rinting Software

o i SRR T

Trash Button
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Feeding and Cutting the Tape

Perform the following steps when you want to feed or cut the tape on the printer
connected to your computer.

To feed the tape

To cut the tape

Click fg@
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Configuring Label Software
Properties

Label Printer properties let you control display of the Input Panel and various other
Label Software features and functions.

To configure Label Software properties

1 On the Input Panel, click [i].
This should display the Printer tab of the properties dialog box.

Label Printing Software Properties

Display 1 Operation 1 Image ] Add4in I

Printer tab __ Layout ] Format 1 Phrase ] Menu I

Model

Frinter | J
Auto Cut Style Half Cut/Full Cut =

Margins Prirt Density
Margins Smal + Light =—— J_ Darkc
12345
QK | Cancel | ‘ Bestore |

You can also display the properties dialog box by right-clicking the Label Software
icon in the status area and then clicking Properties on the shortcut menu that
appears.

2 Use the procedures on the following pages to configure the settings
you want.

3 After you are finished, click OK to apply your settings and close the
properties dialog box.
+ To close the properties dialog box without saving any settings, click Cancel.
« To apply your settings without closing the properties dialog box, click Apply.
« To return settings to their initial defaults, click Restore.
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Configuring Printing Properties

Use the Printer, Layout, and Format tabs to configure printing properties.

To configure printing properties
1 Click the Printer tab.

2 Configure the settings described below.

Large Medium Small
Approx. 21.5 mm | Approx. 10 mm Approx. 3 mm

Margins

« All values in the above tables are approximate.
» Normally, you should leave the Print Density set to 3. Change this setting only
when printed characters are broken or too dark.

3 Click the Layout tab.

Label Printing Software Properties

Layout tab
Display ation | Image | Addin |

| Fomat | Phease | Menu

Printsr |

Font Size/Number of Lines Tape Size

Preset »»
TapeWidh |12 _*|mm

TapeLength |70 _I;l mm

¥ Fix Tape Length

SmallMlines

ok I Cancel | £pply Bestore
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Configure the settings described below.

 The options that appear in the Font Size/Number of Lines list depend on the
tape width.

« When Automatic is selected under Font Size/Number of Lines, the Label
Software automatically selects the optimum text size to fit within the specified
tape length. Selecting Title causes medium size characters to be used in the
first line of text, and small size characters for subsequent lines.

« Clicking the Preset button displays a menu of commonly used preset labels
from which you can choose the one you want. Selecting a preset layout
automatically selects the Fix Tape Length check box.

Margins*' | Auto Cut Style*! Tape Cut Length*? S-I:;fii; ;r;‘?\tge
Half Cut/Full Cut 31 to 300 mm

Small Full Cut only 25 to 300 mm 7 t0 300 mm
No Cut -
Half Cut/Full Cut 38 to 300 mm

Medium Full Cut only 32 to 300 mm 21 t0 300 mm
No Cut -
Half Cut/Full Cut 48 to 300 mm

Large Full Cut only 48 to 300 mm 43 to 300 mm
No Cut -

*1

You can change the Margins and Auto Cut Style settings on the Printer tab.
*2|If the length of the tape being cut is outside the tape cut range when you
perform a Half Cut/Full Cut or a Full Cut only, the tape length will be longer
than the specified tape length.
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5 Click the Format tab.

Label Printing Software Properties

Format tab

Display 1 Operation Image: ] Add-in I
PFrinter ] Layaut { l Phrase ] Menu I
Font
Typeface |Ana\ j

Text Layout

v word\Wiap

™ Justity

Ok | Cancel | ‘ Restore

6 Configure the settings described below.

« Availability of the Label Direction setting depends on your computer’s OS and
the type of font being used for printing. Normally, this setting is Horizontal. The
Vertical setting also becomes available if the OS you are using and the font that
is specified support vertical printing.

* For details about the Word Wrap and Justify settings, see “Word Wrap and
Justification” on page 46.
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B Word Wrap and Justification
The following examples show how the Word Wrap and Justify settings affect label
text.
« [~ Word Wrap /[~ Justify
Example

Special Personal Computer Link software lets wou
incorporate images and data from vour computer in}

to labels. — Carriage return inserted

inside of “into”.

« ¥ Word Wrap /[ Justify
Example

Srecial Personal Computer Link software lets wou
incorporate images and data from vour computer

i — Carri return inser
into labels. Carriage retu serted

in front of “into”.

* [¥ Word Wrap / [+ Justify
Example

Special Personal Computer Link software lets wou
incorporate  images and data from wour computer}

— Carri return inser
into labels. Carriage retu serted

in front of “into”, and
right side of text is
aligned.

« [~ Word Wrap / [ Justify
Example

— Right side of text is
aligned.

incorporate images and data from wour computer im

Special Personal Computer Lirk software lets you}
to labels.
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Editing Phrase Memory Text

Use the Phrase tab to edit phrase memory text you previously registered. You can
cut, copy, paste, and delete text, and you can change the sequence of phrases.

To edit phrase memory text
91 On the properties dialog box, click the Phrase tab.

Label Printing Software Properties

Display | Operation |
PFrinter I Layaut | Format

Group  |LISERT

Robert Jones
Kenny Smith
Anne Brice

ok | camcel | e

Restore |

2 Select the group that contains the phrase you want to edit.
This displays the phrases that are currently registered in the group.

3 Click the phrase you want to edit.
4 Edit the phrase.
» Use the Cut, Copy, Paste, Delete, Up, and Down buttons to edit phrase text.

* You can copy phrase text in one group and paste it into another group.
* You can select multiple phrases by holding down the Ctrl key as you click.
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Configuring Shortcut Menu Settings

Use the Menu tab to configure shortcut menu settings.

To configure shortcut menu settings
1 Click the Menu tab.

Label Printing Software Properties

Digplay | Operation | Image I Add-in |
Pier | Laoud | Fomat | Phase | Meru Menu tab

~Include in Menu

[ 15&ave Phrase
[w]Contest Menu
[ Properties

oK | Cancel | Apply | BRestare |

2 Select the check boxes of the items that you want to appear on the
shortcut menu.

Configuring Display Settings

Use the Display tab to configure display settings.

To configure display settings
1 Click the Display tab.

Label Printing Software Properties

. Printer I Lapout I Format | Phiase I Menu |
Display tab — = "Diplay "]  Operaton | Image | Addin

~ Display

[w]Shaw preview before printing.

[C1keep Input Panel in front.

Show Input Panel when test is appended.
[w]Open Input Panel when program iz started up.
W] Display preview image in actual size.

|3 [ 3

~ Print
[15tap between prints For tape cut.

oK Cancel Apply BRestare
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2 Select (check) and deselect (uncheck) the options you want.
« If you do not want the preview dialog box to appear each time you execute the
Print command, clear the Show preview before printing. check box.
» Select the Display preview image in monochrome. check box to enable
grayscale display of images.

Configuring Shortcut Menu Operation

Use the Operation tab to configure the type of shortcut menu that appears when you
right-click your mouse. You can also specify a modifier key that lets you select the
shortcut menu you want as you work.

To configure shortcut menu operation

1 Click the Operation tab.

Label Printing Software Properties

Operation tab
Printer 1 Fhiase I Menu ]

Display Image ] Add-in ]

Mouse Click

v Dizplay Basic Label Printing S aftware shartcut menu an
right-click.

Mote: Customizing right-click

2 Configure shortcut menu operation as described below.

Software Properties
Printer ] Layout 1 Format I Phrase ] Menu I
Display [ Operion T imags | Addin |
Mouse Click
EN—— Display Label Printing Software shortcut menu on
Whe_n the_che_ck box o When selected
of this option is Note: Customizing fight-cick (checked):
Cleal’ed the Labe| Unchecking the sbove check box causes the cortext menu of h
’ the application you are using fnot the Label Prirter $oftwars « Alt + right.click
Software shortcut context menu) to appear when you right-click with the mouse. .
d i Ater you specsf‘:'-la modfier Tfé‘ tg(e “I..:::elhplr:in(er ds ﬂw?':e context displays the Label
IEN You ni I e noldin wn the
menu oes. no af’pear Mo ke Figh-clking withodt the modfier key Hieplays the Software shortcut
when you rlght-ClICk context menu of the application you are using. menu
. Modi I ci I shit ok N
your mouse odiier Key T = = Ker « Right-clicking only
When selected displays the
(checked): ok ] _cand oy Bestore_ | shortcut menu of
* Ctrl + right-click the other application
displays the Label you are using.
Software shortcut When selected (checked):
menu. « Shift + right-click displays the Label Software shortcut
. R_|gh|t-c||c:ng only menu.
dLSp ays the . « Right-clicking only displays the shortcut menu of the
shortcut menu o other application you are using.

the other application
you are using.
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Configuring Image Settings

Use the Image tab to make image layout settings, specify the monochrome conversion
method, and to show or hide guidelines.

To configure image settings
1 Click the Image tab.

Label Printing Software Properties

Printer I Lapout I Format | Phia: I Menu
Diphy | Dperaton [ Tmee T addin
~ Image Layout i~ Monochrome
Layout  |Left Small vl Dithering
IEnnrD\lfusinn vl
I PResize to fit
™| Maintain aspect ratio Gamma
...... o
~ Capture Image Dark Light
¥ Show Guidelines
oK | Cancel | Apply | BRestare |

—— Image tab

2 Configure the image layout settings you want.
» Use the Layout box to specify the image location and size. The following shows
the available settings and what each one does.

Left Small %

Right Small @
Left Large %

Right Large @
Full Tape

None
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 Selecting the Resize to fit check box enlarges or reduces the image so it fits
within the area specified by Layout. When this option is deselected, the image
is inserted as-is at the location specified by Layout.

« Selecting the Maintain aspect ratio check box causes the width-to-height ratio
of the image to be maintained when it is resized. Note that this option appears
dimmed unless the Resize to fit check box is selected.

Configure the monochrome conversion settings you want.

The explanation uses printing black text on white tape as an example.

» Use the Dithering setting to select the dithering method you want to use. The
following are the available options.

Nearest Color: With this option, light color areas are made white, while dark
color areas are made black. It is best when used forimages that
contain line drawings and text only.

Pattern: This option makes light color areas whiter and dark color areas
blacker.

Error Diffusion: This option makes light color areas whiter and dark color areas
blacker, producing an appearance like you get when you
photocopy a color photograph. Printing with this option takes
longer than with Pattern, but results look better.

» Drag the Gamma slider left and right to adjust the relative darkness of an
image.

Specify the guideline setting you want.

Selecting the Show Guidelines check box displays guidelines indicating the
specified image size whenever you insert an image into a label.
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Configuring Add-in Settings

Use the Add-in tab to configure add-in settings.

To configure add-in settings
1 Click the Add-in tab.

Label Printing Software Properties

Printer ] Layout ] Format } Phrase ] Menu I
Display } Operation } Image

Add-in tab

Installed Add4ns

[w]Movie Player Add-n
[w]Print Image Mimor and Rotate Add-n
[w]Sound Player Add-n

ok | cancel | ‘ Restore |

2 Configure add-in settings as described below.

» The Installed Add-ins lists add-ins you already have installed. Currently enabled
add-ins are those whose check boxes are selected.

» The Add-in Setup button becomes undimmed whenever you select an add-in
name in the Installed Add-ins list by clicking it. Clicking the Add-in Setup button
displays a dialog box for configuring the setup of the selected add-in. The following
describes the settings you can configure for the preinstalled add-ins.

Sound Player Add-in

This add-in plays the contents of sound files whenever printing starts and ends.
Simply input the paths to the respective sound files into the Startup Sound File
and Shutdown Sound File boxes, and click OK. A Browse button can also be
used to select sound files. You can check the contents of the selected sound file
by clicking the Preview button.

Print Image Mirror and Rotate Add-in

This add-in makes it possible to create mirror images and to rotate the printimage
180 degrees. Selecting the Mirror Print option reverses the printimage for printing
to iron transfer tape. The Rotate 180° option rotates the printimage 180 degrees.
Click the OK button after making the settings you want.
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Movie Player Add-in

This add-in can be used to play a video file while printing is in progress. Simply
input the path to the video file into the Video File box, and click OK. A Browse
button can also be used to select the video file. You can check the contents of the
selected video file by clicking the Preview button.

You can use Zoom to change the size of the playback screen, and Display
Location to change the location of the playback screen. Selecting the Mute option
mutes the audio portion of the video file.

53



Using Help

You can access help from the Input Panel, the properties dialog box, and from the
Label Software icon in the status area. You can also display version information about

the software.

To access help from the Input Panel or the properties

dialog box

1 Click the help button.
This causes a question mark to be added to the pointer.

=l=8TP=1200-Label-Printing-Software 7 1x]
o = HelpButton
o Histary e e | = ‘:e
‘&‘& EEE j‘!ﬁ @ Pj il
Font Width  Length  FixedLayout  Image
| izl x| s~ 70 2V [auo | [Home ¥ @
[
2 ‘_ Pointer
) B
Printer ~— Margins Copies
%| ~] |Sma|| = W
2 Move the pointer to the item or area for which you need help and then
click.
=15 TP-1200 Label Printing Software 7]
W s S e
Fant Width  Length FixedLayout  Image
Help text | il > e = o 2V aue | mone -] @
[Text] Box

Shows text to be printed and History File record

’d

’z‘

<] [»
Margins Copies

@ i’rl nter J ‘Sma" J ,—:l W

3 After reading the help text, click with your mouse.
This closes the help box.
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To access help from the status area icon
1 Right-click the Label Software icon in the status area.

2 Click Help and then Search by Topic.

Input Panel
Properties..
Capture Panel

Search by Topic

About the Label Printer Application

Label Software icon

Help Topics: Label Printing Software Help

Conterts | index | Find |

Click & book, and then click Open. Or click another tab, such as Index.

@ Starting and Guitting the Lsbel Printing Software
@ Frintine

@ Usine the Shortout Menu

@ Label Frinting Froperties

@ Input Panel

@ Capture Panel

@ Troubleshaoting

Cancel

3 This displays a Windows help screen.

To view version information

1 Right-click the Label Software icon in the status area.

Search by Topic

About the Label Printer Application

Input Panel
Propertes...
Capture Panel

Label Software icon

2 Click Help and then About the Label Printer Application.

This displays version information.

3 After viewing the version information, click OK.
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Appendix

Tape does not come out of the printer.

* Is the tape compartment cover closed?
Securely close the tape compartment cover. See the printer's user documentation
for details.

* Are you out of tape?
Replace the tape cartridge or thermal roll paper with a new one. See the printer's
user documentation for details.

* Is tape jammed?
Disconnect the AC adaptor, remove the tape cartridge, and then remove the
jammed tape. Use scissors to cut off the tape that was jammed. Reload the
tape cartridge and then re-connect the AC adaptor.

Important!

Never do any of the following while printing is in progress.

» Never allow the tape outlet to be blocked.

» Never touch the tape coming out of the outlet.

* Never open the tape cartridge compartment.

» Never disconnect the AC adaptor.

» Never disconnect the USB cable.

See the printer's user documentation for details.

» Computer USB port is not enabled.
Check to make sure that the USB cable is connected correctly. Check to make
sure that the COMPUTER LINK button is depressed. Also, perform the
procedure below to check if the computer's USB port is enabled.

How to check if your computer’s USB port is enabled
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Tape does not come out of the printer.

Windows 2000 Professional/XP

1. Log in to Windows 2000 using an account that has Administrator privileges.
2. Click Start - Settings - Control Panel.

3. Double-click the System icon.

4. Click the Hardware tab and then click the Device Manager button.

5. Click the plus symbol next to Universal Serial Bus Controllers.

Windows Vista

1. Click Start - Control Panel.

2. Click the System and Maintenance.

3. Click the Device Manager.

4. Click the Continue button on the User Account Control window.
5. Click the plus symbol next to Universal Serial Bus Controllers.

If both USB Host Controller and USB Root Hub appear under Universal Serial
Bus Controllers, it means your USB port is enabled. If you have multiple hubs in
your USB chain, try connecting the printer's USB cable to a separate hub or to
another device. Make sure you connect the cable securely.

If USB Host Controller and USB Root Hub are not displayed under Universal
Serial Bus Controllers, see the documentation that came with your computer or
contact your computer’s manufacturer for information about USB setup and
procedures for enabling the USB port.

Tape comes out of the printer, but nothing is printed on it.

* Did you input any text?
Input some text into the label.

 Label contains non-printing character codes
Your Label Software will not print or display a preview of a label that contains
blank spaces, carriage returns and tabs only.
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Print quality is poor.

* Are you using a proper print density setting?
Change the print density setting. See “To configure Label Software properties”
on page 42.

* Is the tape cartridge loaded correctly ?
Correctly load the tape cartridge. See the printer's user documentation for
details.

« Is the printer head or rubber roller inside the printer dirty?
Clean the printer head and rubber roller. See the printer's user documentation
for details.

Ink ribbon is coming out of the tape outlet together with the tape.

» Was the ink ribbon slack when you loaded the tape cartridge?
Remove the tape cartridge and make sure the ink ribbon is not broken.
Correctly load the tape cartridge. See the printer's user documentation for
details.

Important!

» Make sure you take up any slack in the ink ribbon before loading the tape
cartridge into the printer.

« If the ink ribbon ever breaks, replace the tape cartridge with a new one.

Printing stops part way through.

« Is the printer head overheated?
The printer head heats up during printing. If you print a large number of
consecutive labels or print labels that contain a large amount of black areas,
the printer head can overheat, which causes printing to stop automatically.
Simply leave the printer alone and the printing will resume when the print head
cools down.
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The tape does not cut.

* Is label jammed?
Remove the tape cartridge and then remove the jammed label. See the printer's
user documentation for details.

« Is tape cutter worn?
Contact your retailer to have the cutter replaced.
* Is the No Cut option selected?
Select a different cutting option.
» Are you using a short tape length (30mm or less with small margins, 37mm or
less with medium margins, or 47mm or less with large margins)?
After printing is complete, use the cutter button to cut the tape.

Half cutting is not performed.

« Is tape cutter worn?
Contact your retailer to have the cutter replaced.

« Is the No Cut option selected as the Auto Cut Style option?
Change the Auto Cut Style option setting to Half Cut/Full Cut.

Important!

» Make sure you take up any slack in the ink ribbon before loading the tape
cartridge into the printer.

» Note that half cutting cannot be performed when you are using reflective tape,
magnetic tape, or any other special tape.
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Tape does not adhere properly.

« Did you peel off the backing paper?
Peel off the backing paper from the label. See the printer's user documentation
for details.

« Are you trying to affix the label to a compatible type of surface?
Make sure the surface or area where you are affixing the label is compatible.
See the printer's user documentation for details.
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Error Messages

If this message appears:

Do this:

No connected device

Check the connection between the printer
and computer. After correcting the
problem, try printing again.

Tape size setting error

Check if the tape loaded in the printer is
the right size. After correcting the
problem, try printing again.

Cut setting error

The tape loaded in the printer is magnetic
tape. Magnetic tape cannot be half cut
using a printer’s cutter. When using
magnetic tape, change the Auto Cut
Style setting to No Cut.

Tape is jammed inside the printer

»

If tape is jammed, see “Printing Problems
on page 56 for more information.

No tape is loaded in the printer or
tape is jammed inside the printer

Check to make sure that a tape cartridge
is loaded, tape is not jammed, that the
tape width is supported and that the tape
cartridge is not out of tape. If tape is
jammed, see “Printing Problems” on page
56 for more information.

The printer is busy.
Wait until printing from the other
application is complete and try again.

Wait until the other application is through
printing and then try again.

There are too many characters to fit
on the specified tape length.

OK to adjust the tape length
automatically?

Click OK if there is no problem with
printing a long tape. To print a specific
length, click Cancel to return to the Input
Panel, change to a smaller character size,
or reduce the number of characters. After
you are finished, try printing again.

Printer batteries are low.
Continue printing.

Clicking OK starts printing, but the printer
may turn off if battery power drops below
a certain level. If this happens, replace
batteries or use the AC adapter.
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Label Creation Problems

Using the STP-1200 Label Printing Software

» Cannot append selected text into the Text Input Box.
Try selecting the text you want and copying it to the Windows clipboard and then
performing the append operation. With most applications, you can perform the copy
operation by selecting the Copy command on the Edit menu.
Not enough memory to insert or print an image.
If the message “There is not enough memory to execute that command.” appears
when you try to insert an image into a label or print a label that contains an image, it
could mean either of the following.
» There is not enough memory to perform the operation. Quit other applications
you have running and try again.
» There is a problem with the Windows display driver. Contact the manufacturer of
your computer for more information.
» Images become all black when printing
The image you are using may be too dark. Try either of the following to adjust image
brightness.
» Use Paint or some other graphic application to increase the brightness of the
image.
* What to do when the Input Panel appears with your computer’s screen saver
With some screen savers, the Label Software Input Panel may remain on the display
with the screen saver if you have the Keep Input Panel in front. option selected on
the dialog box that appears when you select Properties - Display. If this happens,
turn off the Keep Input Panel in front option, or hide the Label Software input
panel.
« When expanding to the full-screen Acrobat Reader or Adobe Reader view
Close the Label Software screen before expanding the Acrobat Reader or Adobe
Reader screen to its full-screen view.
» What to do when you can’t get to Label Software context menu to appear on the
display
The Label Software context menu may not appear when this software is used in
combination with certain applications. If this happens, highlight the text in the
application you want to select, and then select Print, Append, etc. using the Label
Software Input Panel.
Precautions when using mouse click modifier keys
Under initial default settings, right-clicking the mouse displays the Label Software
context menu.
You can use the Label Software Properties dialog box to change this so a modifier
key (Ctrl, Shift, Alt) is required while right clicking to display the Label Software
context menu. If your Label Software is setup to require a modifier key to display its
shortcut menu, make sure you release the keys before using the mouse or up/down
arrow keys to select a command on the menu.
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* Preview window precautions
You may experience slow response when typing large amounts of text into the text
box on the Input Panel while the Label Software preview window is on the display. If
this happens, try closing the preview window and then typing or editing text.

» What to do when dots are missing from characters
The Label Software prints within the full area of the label tape width you are using. If
the preview window shows part of your text is being cut off, try something like the
following to correct the situation.

» Change to another font that prints without missing dots.

» What to do when you have problems with the Windows desktop context menu
While typing or editing text on the Label Software Input Panel, you may experience
problems performing operations on the context menu that appears when you right-
click on the Windows desktop. If this happens, click anywhere on the Windows desktop
and then right-click to display the Windows context menu.

Using Another Application

» The shortcut menus of the other applications are different after installing this Label
Software.
While the Label Software is running in the background on your computer, holding
down Ctrl and then right-clicking your mouse displays a Label Software shortcut
menu.You can change how the right-click operation works by configuring the settings
under “Configuring Shortcut Menu Operation” on page 49.
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